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Introduction 

WaterMark PRO is a full-featured object-oriented lawn irrigation design software incorporating time-proven hydraulic 
engineering techniques and a user-friendly interface that greatly accelerates the design process.  WaterMark PRO was 
developed with the goals of flexibility, speed, simplicity, and ease of use. The software assumes the user’s basic 
knowledge of sprinkler system design. 

The system interfaces with an independent database containing all system parts and provides automated, system-
generated reports to facilitate the estimating, pricing, planning, and physical implementation phases of the irrigation 
project.  The database includes sprinkler heads, bodies, pipe and pipe fittings, clocks, tools, accessories, valves, and even 
labor charges. 

The program runs on the Microsoft Windows™ operating system and should run successfully on any currently supported 
version of Windows™. We recommend running it on the latest version for the best results. 

The Metric Version also utilizes this user guide. Both the US as well as the Metric versions of the programs utilize their 
native measurement standards, including the parts library. To avoid managing multiple user guides, it will only be 
published in the US version, so please be aware of the following substitutions as you read through the guide. Of course, 
the metric version of the program itself utilizes all metric measurements. 

Measurement US Version Metric Version 

Water Pressure PSI (pounds per square inch) Bar (barometric pressure) 

Water Flow GPM (gallons per minute) LPM (liters per minute) 

Linear Measure Feet or (‘) or Ft. Meters or M. 

Precipitation Rate Inches/hour (in/hr) mm/hour (mm/hr) 

Area Square feet (sq ft) Square meters (sm or m2) 

 



 pg. 3 

Setup 

Following successful installation, launch the program. The following screen will pop up: 

 

If you haven’t already purchased the program and wish to launch the free trial version, click the “Start/Continue with 
your 30-Day Trial (Limited Capabilities)” button to launch the program in trial mode. You will have 30 days to demo the 
program but with limited capabilities: disabled saving of projects, disabled ability to add to the parts database, and 
inability to upload your organization’s logo and provide other branding information. Other than the above, all functions 
will be available. 

If you wish to purchase the full version of WaterMarkPRO3: (you must be connected to the Internet) 

1.  Go to STEP 1 in the figure above and click the “Purchase WaterMark PRO3” button which will take you to the 
purchase page of our website. 
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2. If you’ve purchased WaterMarkPRO3 and have received your Purchase ID that you copied from the Purchase ID 
email, go to STEP 2 above and click the “Obtain A Registration ID” button and fill in the Web page form with your 
Purchase ID. The system will then email you with your Registration ID (see STEP 1 above). 

3. If you’ve purchased WaterMarkPRO3 and have received your Registration ID that you copied from your Registration 
ID email, enter it in the text box in STEP 3 above and click Submit. The program will open into the full version and 
will include the ability to save projects, manage the parts database, and enter your organization’s logos and other 
branding information.  

4. Note: If you’ve purchased a previous version of WaterMark PRO, please contact us at support@watermarkprol.net. 
We will provide you with a discounted license to WaterMark PRO3 once we’ve verified your purchase. 

Upon opening If you see “The WaterMark PRO Parts Database was not found. Would you like to find it yourself?” 
notification, click OK to navigate to the folder where the wmdb.mdb file is located: 

(C:\Program Files (x86)\Science Hill LLC\WaterMark PRO 3). Click on the wmdb.mdb file to lock in the location. The 
location will be stored permanently. 

In case of any other difficulties launching the program, please contact Science Hill Support at (303) 807-7500 (8-5 MDT, 
M-F) or email us at support@watermarkprol.net. 

Once the program launches, you should be greeted with the following main screen: 

 

support@watermarkprol.net
file:///C:/Users/atede/source/repos/WMProR/support@watermarkprol.net


 pg. 5 

Initial Printer Setup 

The drawing surface is designed to mimic the paper size of your printer; therefore, you must scale the drawing screen to 
comfortably size the drawing onto your printer paper.  Select the main menu item in the upper left corner of the 
window.  The main file screen opens (below image). Click the “Print/Print Setup” button. Make certain that the correct 
printer is selected for the drawing.  Next, determine the paper orientation.  If your sketch is drawn so that the layout is 
taller than it’s wide, select "Portrait" orientation; otherwise, choose "Landscape" (landscape is preferred).  Also, choose 
the available paper size you intend to use (the larger the better - items on the layout will be easier to read).  Click "OK" 
and return to the drawing screen. 

It's not necessary to have a physical printer connected to your computer, just that you’ve loaded a printer driver of 
some type that will frame out your drawing surface. You can always go back and add a printer after completing your 
project. 

Note the extreme dimensions of your property sketch.  Obviously, the entire drawing must appear on one page. 
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Designer Favorites (full version only) 

Click the “Designer Favorites” menu item on the System tab: 

 

 

The Designer Favorites sheet opens: 

The Designer Favorites screen allows designers to pre-pick their favored series of heads and individual parts, thus 
simplifying the selection process when assigning them later to a project. Additional parts can be manually added to the 
database – see the “Modifying the Database” section later in this manual (full version only). Note the button to the right 
of the “Body” drop list. Click it to add/edit individual model and pricing information. Unlike the head series drop lists, the 
body drop lists display individual items that require pricing if used in projects that generate estimates or invoices. 
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The first step is to decide on the types of sprinkler heads you’d like to use in your projects.  On the “Head Series” tab, 
you can select a different series of heads for both the small lawn areas as well as large areas.  If a nozzle series is chosen, 
select the nozzle body that you intend to pair up with those nozzles.  Select the “Plant Heads” tab to choose your 
preferred shrub/tree and garden heads.  Later, as you create new projects your designer favorites will be displayed in 
the Project/Client Data/Favorites area, thus simplifying the parts selection process (but you have the option of changing 
your mind later).   

On the Head Series tab only, head product series are displayed and not the specific heads. This way, when utilizing the 
Auto Head design function, the system can select individual heads from the series to intelligently place on the plots. 
Note the “Details” button to the right of the series. The head series detail screen opens which displays all the different 
heads/nozzles of the series: 

  

Click the “Edit” button to the right of a model to make database edits to that item (full version only): 
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Here you can make edits to the model number, description, and pricing of the item. The prices entered will be reflected 
in any report/invoice or estimate generated by the system. Click the “Advanced” button to modify the physical specs of 
the item (full version only): 

 

Select the remaining tabs to select favored parts related to the various portions of the project (parts related to the 
headsites, manifold/zone, system, and project parts). Click the button to the right of each selection to edit the 
model/description and enter pricing information. 

Note that we provide both a retail price and a cost price. The cost price is provided to allow the designer/contractor to 
enter their cost for the product. This could be an estimated cost in the case of labor or equipment usage. With both cost 
and retail stored away, compiled numbers related to gross/net profit of individual projects can be recorded and utilized 
in determining pricing and business growth strategies. In the auto-generated parts reports, the option exists to hide the 
cost or retail columns on the printed output. 
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Click the “Designer Profile” menu item above. Fill in your company information that is displayed on reports. 

 

Click the “Load Logo” button in the system menu to select and upload your company logo to drawings and reports. You 
may have to modify its size to fit properly. The logo graphic can be in the form of .jpg, .png, or .gif formats. The logo 
graphic should be approximately 62 x 62 pixels in size. Paid clients can forward their logos to us and we will size them at 
no additional cost. 
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Start A New Project – Setup 

The program opens to a blank project, or you can create a new one by clicking the “New” button below: 

 

The Open… button opens any projects you’ve saved, the Save… button (not operational in the trial version) saves 
projects to your computer and Save As… saves a copy of an existing project under a new name. We’ve included a couple 
sample programs for you to view, Demo1 and Demo2. Click Open to load them. 

The Print button allows you to print your drawings and reports and the Print Setup screen lets you select your default 
printer, page orientation, and various other printer properties. Make sure to select a default printer to define your work 
surface size. Click Print Preview to show how your drawings and reports will look prior to printing them. 
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Once you’ve created a new document, the first step is to fill in the project data. Click the Project Tab/Client Data/Client 
button: 

 

The Client Profile Dialog Box Opens: 

 

Fill in the text boxes as indicated above. Enter the project’s available water pressure (PSI) and water flow (GPM) 
available at the head of each zone. 
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Click the Project Tab/Client Data/Favorites icon to open the Favorites Dialog Box: 

 

If you populated the “Initial Designer Favorites” (full version only), the Favorites will already be filled in with those items. 
If not, select your preferred parts for this project (see directions from “Initial Designer Favorites” above), or change any 
that were brought over from your designer favorites. Selecting system preferences simplifies selecting parts for your 
project. Once you’ve made these selections, they will be saved along with the project you’ve created (full version only). 

The next step is to set the drawing scale. Click the “Scale” button below to open the “Drawing Scale” dialog box. 

        

Here you must consider the scale of the drawing compared to the actual property you wish to bring into your project.  
Select a number that comfortably fits the property within the screen’s dotted boundary and informational footer.  
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The “SnapToGrid” button is selected by default upon creating a new project. Deselect if you don’t want your drawing 
objects to snap to the grid points. 

You may also wish to adjust the spacing between grid points by clicking the “Grid” button. The following dialog box 
opens: Select a grid spacing or use the default spacing of .1, which works well for most drawings. 

 

View Menu 

The “View Menu” enables the ability to add or remove layers from the drawing screen. Note the various layers in the 
menu area: 

 

The above selections define the default layers shown. Check or uncheck layers to provide the view of the drawing screen 
desired. Utilize Print or Print Preview to generate helpful views without being obscured by other layers. For example, if 
you wish to print out a diagram of head numbers and piping, uncheck all except for Heads, Head Number and Piping. 
Then it’s simply a matter of printing a Heads by Plot or Heads by Zone report to mark head and piping positions on the 
property. 

Other helpful menu items: 

 

The “Edit Tools” panel provides several helpful tools. Utilize the “Cut”, “Copy” and “Paste” tools to duplicate 
components throughout a project. Simply select the item and then click the appropriate button to execute the function. 
Utilize the “Delete Object” function to delete any selected plot, component, or static drawing item. 



 pg. 14 

Adding Plots 

Plots designate the various areas with the property. Plots can be “wet” (fine grasses, coarse grasses, shrubs, gardens, 
trees) or they can be “dry” (structures, driveways, walkways). When adding the plots, consider the logical breakdown of 
the property. 

Plots must be separated and can’t overlay each other. 

 

The following drawing tools are available for drawing plots: Rectangle tool, Circle/Oval tool, Line and Curve tools. Entire 
closed plots can be created with just the Rectangle or Circle/Oval tools.  The Curve tool and Line tool both create 
arcs/sides of a plot and must be connected end-to-end to create a closed area which becomes a plot once whole. The 
Circle/Oval and Line tools can be used together to create virtually any shaped plot. 

 

The following plot layout defines a typical residential project property. Note that the top left corner of the top and side 
rule defines the (0,0) point of the drawing. All measurements should be referenced from this point. Back yard was added 
with the “Coarse Grass” type; front with the “Fine Grasses” type; house with the “Structures” type; shrubs, garden and 
walkway as noted. 
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To add a plot, first select the plot type from the “Add A Plot” button, select a drawing tool (in the below case, a 
rectangle), and click the right mouse button to trace the rectangle onto the drawing. Start at the top left of the rectangle 
and move the mouse, while holding down the right button, completing the rectangle at its right-bottom point.  
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Clicking OK completes the plot onto the drawing surface. Prior to clicking OK, you may wish to change the name of the 
plot to match the actual property area: 

 

Utilize the line and curve tools to create non-rectangular, non-circular plots. The final shape must be closed by 
connecting the last selected point to the first. Hold down the Ctrl key while drawing lines to confine the line tool to the x 
and y axes of the drawing. 
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Editing Plots 

Plots can be removed by first selecting the plot (click the “Edit Plot” button and left click over the plot to select it) and 
then click the “Delete Object” button; alternatively, right clicking the mouse will reveal the plot’s context menu. 
Selecting “Delete Selection” will also remove the plot, or simply clicking the “Delete” button on the keyboard 
accomplishes the same.  

Plots can be moved by selecting the plot, positioning the mouse cursor over the plot while holding the left mouse button 
down and moving the mouse until the plot moves to the desired location. Small, micro movements can be made using 
the arrow keys on your keyboard. (Note: moving a plot will include moving the plot’s array of heads/zones, but not 
piping or valve sources, which are always relative to the drawing coordinates.) 

The mouse pointer’s location can always be monitored by viewing the X and Y position displayed on the left side of the 
window’s status bar: 
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Plot details can be edited by selecting the “Object Properties” button or the Properties item from the context menu, 
revealed when right-clicking the mouse button (the plot must be selected): 

The Plot Properties dialog box opens: 

 

From the Plot Properties, you can make several changes: The plot’s Name, Soil Type, Solar Exposure, Slope, Slope Crest 
Side can be modified, and Water Demand can be selected. Once the watering components have been added, a 
precipitation rate will be calculated for the plot. At this point, a water demand can be selected (or suggested, based 
upon all the above settings). The system will calculate a suggested number of watering periods per week and watering 
times per period. Click the “Override Suggested Watering Periods Per Week” button to override the number of watering 
periods per week, and the “Time Per Watering Period” time will change. 

The Location/Size Coordinates group provides the plot’s location coordinates, size, and area. These indicators can only 
be edited by removing the plot and re-adding it. 
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Adding Headsites 

The term “headsite” refers to the location and physical parts that comprise a specific sprinkler head’s location, head 
type, and settings as well as any associated parts (riser, tees, swing joints, etc.).  

Headsites can be added either manually or by utilizing WaterMark Pro’s “AutoHead” design tool that automatically 
places headsites within a selected plot. AutoHead design tools are discussed later in this manual. For now, manual 
placement of headsites will be addressed. 

 

To add a headsite to a plot, first select a “wet” plot (click the Edit Plot button and left click over the plot). Now click the 
“Add A Component” button and select the “Headsite” item.  The mouse cursor becomes a crosshair. Position the 
crosshair over the spot you wish to locate the headsite and left click the mouse button. To assist in manually placing 
headsites, activate the “SnapToHead” button which displays a “help” cursor once it’s near a corner or center of a 
rectangular plot. 
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When clicked, the Headsite Properties dialog box appears: 

 

If you’ve completed the Favorites section above, your preferred head series for this type of plot is displayed in the 
“Series” box. If not, select a series from the dropdown list. 

Once a series is selected, click the “Head” drop down box and select a specific head (or nozzle) part. The spray pattern 
will be noted in its description, so match the pattern to the area within the plot where you want it positioned. Click the 
“Body” list to determine whether a sprinkler body must be selected for the head. If empty, the selected head doesn’t 
require a separate body. 

Configuration: 

• Click the up/down arrows to the right of the Position/Angle item to position the spray pattern within the plot. 

• Click the up/down arrows to the right of the Radius/Width item to widen or lessen the spray radius. The head’s 
max and min spray radius are programmed with the part’s database record based upon manufacturer specs. 

• Click the up/down arrows to the right of the Adjust. Angle item to adjust the head’s pattern. This adjustment 
will be unavailable for fixed pattern heads and only used with adjustable pattern heads. 

• When editing an existing headsite and upon changing one of the parameters above, clicking the Apply button 
will transmit those changes to the main drawing screen where you can view the actual change. Note that once 
the Apply button is clicked, the changes will occur even if the “Cancel” button is activated. 

• Note:  If the head's required pressure exceeds pressure availability less a safety buffer, a caution message will 
appear when you attempt to close the window.  You will have the opportunity to change parameters or 
continue with the existing pressure settings. 

Other Headsite functions...... 

The top area of the Headsite Window (ID) contains positional information as well as plot number and headsite number 
(relative to the plot).  Also shown in the Current Configuration panel is the head's precipitation rate.  This is the amount 
of water spread over the area of coverage per hour of operation.  Precipitation rates from all heads in the plot are then 
summarized in the Plot Properties window and can be viewed by selecting Plot Properties as described above. Clicking 
on "Head Details" brings up the Head Detail Window that provides more information about the selected head.  At this 
point, you can also assign other system parts to this headsite, such as risers, ells, etc.  We recommend that this action be 
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completed when all heads are assigned, as you can clone all headsite parts within its parent plot, thus saving time. 
Details are discussed later in this document. 

Click the “Add Parts” button to assign additional hardware to this headsite. The “Edit Headsite Parts” dialog opens: 

 

Any headsite favorites previously selected will display on the left of the screen. Click the +/- buttons to the left of the 
part type folder icons to display the parts. To select a part, simply click the part and click the “Add” button to place it on 
the selected list to the right. After adding, you can change the quantity (defaults to 1) by clicking on the selected item 
and then clicking the “Quantity” button. To remove an item, click the selected item and then the “Remove” button.  

To view the entire library of parts, uncheck the “Show Favorites” button. Click the “Edit Favorites” button to update the 
Favorites selections. 

Clicking the “Clone Parts” button will automatically add the assigned parts to any other headsites that already exist on 
the parent plot. 

Editing Headsites 

You can always edit any head/headsite that has been added to the system.  Click the "Edit A Component" button. 
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To edit a head/headsite, click over the center-point of the head's radius (or center of the square).  The outline of the 
head center area will turn red - now select “Properties” from the “Edit” menu.  (You can access the Properties menu 
from the right mouse-click context menu).  Once the Headsite Properties Window is opened, you can make any changes 
you wish to the head or headsite. 

You can also delete a head/headsite by selecting the head (as noted above) and clicking "Delete" from the “Edit” menu.  
Headsites may also be moved by selecting the head, and while holding down the left-mouse button, moving it around 
the plot. Use the keyboard arrow keys to make small changes to the headsite’s position. 

Copying & Pasting 

WaterMark PRO contains several features that speed and simplify the process of head layout.   Oftentimes you will wish 
to copy existing identical heads to other locations within the plot without having to go through the entire configuration 
process (this is particularly handy with half-circle heads).   

The "Edit A Component" button must be selected while performing these procedures.  To copy a head, simply select the 
head as noted above and then click the "Copy" item from either the "Edit" menu or the popup menu.  Move the cursor 
to the point where you would like to copy the head and then select "Paste" from the "Edit" or popup menus.  If the head 
isn't placed exactly where you like it, move it as described above, or edit it by selecting its properties screen. 

You may also "Cut" and "Paste" a head by selecting the head, clicking the "Cut" command and then pasting the head to 
the new location using the "Paste" command.   

Headsite Layout - Completion 

Continue to add heads to the parent plot and continue to populate the remainder of the "wet" plots with heads.  
Gardens and shrubs can also be part of the system if your head catalog contains heads appropriate to these areas. 

Now would be a good time to revisit each Plot Properties window.  See the Plot Properties discussion above for details. 

Auto Head Design Tool 

The manual headsite functions are mostly useful for adjustments while tweaking a design, but the Auto Head design 
tool is the preferred method for adding headsites.  

Preparing to auto-design headsites is straightforward, yet important for the accurate processing of the auto-design 
function.   

Since auto-design relies on the selection of a preferred head/nozzle series part, make certain that the Favorite parts are 
selected as described in the “Start A New Design Project – Setup” section above.  If available, choose adjustable head 
series for irregular plots (multi-sided or curved areas).  Fixed nozzle series (i.e., quarter-circle, half-circle, etc.) work well 
in rectangular areas. 

The auto-design function extracts hydraulic information from the "Project/Client Data" window, so this information 
must be available for the calculation of head spacing and spray radius. 
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The auto-design process can add headsites for a selected plot or for all “wet” plots in the drawing.  To design a single 
plot, select that plot. 

Click the “Auto Add Heads” link.  The system will ask whether you wish to design headsites for all the drawing’s plots.  If 
you select “NO”, the system will design headsites for only the selected plot. 

If headsites already exist on the plot, the system will prompt you of this fact and ask whether you wish to continue 
(existing headsites will be deleted) or cancel out of the process. 

Automatic Headsite Design – Options 

The “Auto Head Design Process” window will now appear.  This window offers several configuration options prior to the 
actual auto-design procedure: 

 

Select a Control Border:  The control border determines where the process will begin its placement of headsites along 
the perimeter of the plot.  Select the control border that requires the most accurate head placement (to avoid 
overspraying boundary areas).  Heads will be “fitted” within the control border with appropriate spacing and spray 
radius (based upon available water pressure and flow).  You can also decide to select “None” (the default).  This option 
will maximize spacing and spray radius, but no attempt will be made to “fit” headsites along any border.  For rectangular 
plots, the system will also attempt to fit headsites along all sides based upon the spacing and radius derived from the 
control border. 

Wind Speed:  If the watering areas are prone to constant winds that might divert water spray from their designated 
targets, the system provides an option to space the heads closer together to assure better coverage using industry 
standards.  Select an option that matches your wind condition. 

Spacing:  Select triangular spacing to place headsites at the vertices of equilateral triangles that fill the plot.  Triangular 
spacing is always recommended for non-rectangular plots because the number of headsites is usually minimized, water 
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coverage is more consistent, and water consumption is generally less than with square spacing.  Square spacing works 
better in plots that require a small number of headsites – typically in rectangular areas utilizing rotor-type heads. 

Internal Head Count Density:  This option allows you to “tweak” the number of heads designed by the system.  Since the 
procedure relies on numerous calculations based on disparate hydraulic and geometric values, design output may not 
always be “perfect”.  You may wish to delete the generated headsites and repeat the process with a different density 
value. 

Headsite Parts:  Select any headsite parts that you wish to be added to the generated headsites (risers, ells, etc.). Please 
see “Other Headsite Functions” section above for details. Whatever you select will be added to the current plot’s 
generated headsites. If the above option was to add headsites to all plots, the selected parts will be added to all the 
generated headsites in all the plots. 

Edit Favorites:  If you haven’t already selected preferred head/body parts for the procedure, you may do so at this point. 

As with any computer-generated function that attempts to mimic the human brain, it’s often impossible to do so with 
perfection.  Though the auto-design process is extremely sophisticated, it’s important that you review the output for 
anomalies resulting from the complex interaction of the numerous hydraulic and geometric calculations.  Rectangular 
areas (with a selected control border) will be designed with the most accuracy, but irregular areas may require some 
adjustment of head placement and/or spray angle.  Again, avoid using “fixed” nozzles in irregular plots. 

Utilize the manual functions outlined above to implement your adjustments. 

Adding Manifolds/Zones 

Like their physical counterparts, WaterMark Pro manifolds define the watering zones and all its integral parts.  

To add a manifold (or valve box location), click the "Add A Component" button and select the “Manifold” menu item.  
Move the mouse crosshairs to your chosen location on the drawing and click the left mouse button.   

 

The Manifold/Zone Editor window starts out with no zones. Click the Zones - New button to add Zone 1. To add heads to 
the zone, click the + symbol next to the plot icon in the tree list.  Click the + symbol next to plot 1 to reveal all the heads 
assigned to this plot. 

Heads can now be added to Zone 1.  Feel free to move around the window to reveal plot/head numbers on the drawing 
surface below.  Attempt to group heads in such a way that the pipe lengths will be as short as possible and that the head 
groups are logical (always group like heads together - never mix impact with spray or strip heads).  Assign heads from 
any plot to a zone if the selection makes sense.  To reference a head, select the head on the tree list and click the Heads 
- Add button.  Notice that the selected head is removed from the tree list and has been added to the list box on the 
right. 
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As heads are added to the zone, note the flow information to the right of the list box.  When a head is added to the 
zone, the total flow required for all heads will be displayed.  Below is the total system flow available that was calculated 
from the Client Data window earlier.  Attempt to include a fair safety margin to assure that the heads perform as 
designed over all water availability conditions. 

If you change your mind about a selection, simply select the head in the list and click the Heads - Remove button to 
remove the head from the zone list and return it to the list of unreferenced heads on the tree list.  Again, at this point 
we can add the zone fittings, valves, etc., but it’s more convenient to perform this after all zones have been created.  
Continue to add zones and heads until all heads have been assigned to a zone. 

Edit Manifold/Zones 

 

Note that the inner circles/squares of each head have been color-coded to match the zone to which they are referenced 
(same as the color in the Manifold/Zone Editor window).  In the case of multiple manifolds, the same color is used for 
zone 1, 2, etc., on each manifold.  Unreferenced heads are colored a neutral gray. 
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The process of editing zones, manifolds, and piping is straightforward.  As with headsites, click the "Edit A Component" 
button.  Select the manifold you want to edit (or after opening, a zone assigned to that manifold).  Add or remove any or 
all heads from a zone.  Note:  If all heads are removed from a zone, that zone will be automatically deleted from the 
manifold when the window is closed. 

You can also delete an entire manifold (which deletes all the zones and head references - not the actual 
heads/headsites).  Simply select the manifold and click "Delete”. 

Auto Zone Design Tool 

 

Like the Auto Head design tool, the Auto Zone design tool is the recommended process for adding zones to a project.  

WaterMark PRO provides a function to automatically create watering zones and then assigns those zones to headsites 
within a plot.  Though straightforward, the process requires some preparation. 

Since zones must be assigned to manifolds, make certain that manifolds are created at their planned positions.  Large 
areas that may require 12 or more zones are usually better served with multiple manifolds.  The auto-zone procedure 
supports multiple manifolds servicing a single plot (or over several plots). 

Since zones are configured based upon available water flow, the “Project/Client Data” information must be available to 
the process. 

The auto-design process can design zones for a selected plot or for all populated plots in the drawing.  To design zones 
for a single plot, first select that plot. 

Click the “Auto Add Zones” menu item.  The system will ask whether you wish to design zones for all the drawing’s plots.  
If you select “NO”, the system will design zones for only the selected plot. 

If zones already exist on the plot, the system will prompt as to whether you wish to continue (existing zones/system pipe 
will be deleted) or cancel out of the process. 

The “Auto Zone Assignment Properties” window will now appear.  This window offers several configuration options prior 
to the actual auto-assignment procedure: 
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Target Manifold:  The drop-down box contains all existing manifolds.  Select the parent manifold for the generated 
zones. 

Multiple Manifolds Services This Plot:  This checkbox is enabled when multiple manifolds exist on the system.  Check 
the box if you wish to split zones within this plot to multiple parent manifolds. 

Target Plot Quadrants:  These options are enabled if the above box is checked.  Check one or more boxes to determine 
which headsites positioned relative to the target manifold will be assigned to a zone serviced by the target manifold. 

Zone Geometry: Select “Linear” (default) to assign heads linearly and “Cluster” to assign heads in a cluster. 

Click OK to assign the zones.  Repeat the process for each zone. 

As noted in the “Auto Head Design” discussion above, click “Select Parts” to add zone parts to the created zones and 
“Edit Favorites” to edit or add parts to the zones. 

As with any computer-generated function that attempts to mimic the human mind, it’s often impossible to do so with 
perfection.  Though the auto-assign process is extremely sophisticated, it’s important that you review the output for 
anomalies resulting from the complex interaction of the numerous hydraulic and geometric calculations.  Zones in 
rectangular areas will be designed with the most accuracy, but irregular areas may require some adjustment of zone 
headsite assignment.  

Utilize the manual zone assignment functions outlined above to implement your adjustments. 

Adding Pipe 

System pipe type can be assigned either directly to a zone, a manifold (all zones assigned to the manifold will use the 
same pipe) or to the entire project (all manifolds and zones will use the same pipe). In most cases, a design will utilize 
the same system pipe throughout, but WaterMark PRO leaves you the option of specifying pipe down to the individual 
zone, which will be essential with drip systems, etc. Use this tool to also add main line piping to the project (see below). 
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To assign a system pipe type to an individual zone, open a manifold for editing.  Now select a zone from the drop-down 
list.  Click "Edit Zone Parts". See the discussion above relating to adding parts to headsites. 

Adding System Pipe - Assigning Pipe Type to a Manifold and Project 

If you wish to assign different system pipe types to different zones, follow the instructions above.  In most cases, though, 
the same pipe will be utilized throughout the entire manifold (or the entire project, in the case of multiple manifolds). 

To assign system pipe type to an entire manifold, open the manifold in edit mode, as before.  Now select the "Edit 
Manifold Parts" button.  The same Parts Window is exposed.  Dig down the tree list to the specific pipe type to assign to 
the manifold and click "Select System Pipe". 

To assign system pipe to the entire project (multiple manifolds) is even simpler.  Select the "Add Project Parts" button. 
Follow the same procedure above to assign a system pipe type to the entire project. 

 

Adding System Pipe - Pipe Layout 

The system pipe connects the heads to the zones and then the zones to the manifold.   All system piping in the Pipe 
Catalog is listed "per foot" so that pipe lengths can be totaled when creating the materials reports. 

To add pipe to a zone, you must first select a zone - to do so, simply select one of the headsites assigned to that zone 
("Edit A Component" button").  While the head is still selected, click the "Add A Component/Piping" button.  You can 
now draw the pipe segments onto your drawing.  Pipe will be colored the same as the zone color for easy recognition.  
As you connect pipe segments, the system will "snap" a connection at their endpoints to facilitate drawing.  When 
branching 90 degrees from a pipe run, set the cursor on the source pipe until the crosshair highlights   Make sure to 
draw the main trunk from the manifold area to all zones.  Continue with all zones in the same manner. 

 

Adding System Pipe - Editing 

To edit system pipe segments, simply delete and re-draw them.  Select the pipe item ("Edit A Component" button) and 
click the "Delete" item from the Edit menu or right-click the "Delete Selection" item. 

To edit the pipe part type, select the pipe segment and click the “Edit A component” menu item. 
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The Pipe Properties screen opens. 

 

Adding Main Line Piping 

Select the Piping link above to add main line piping. Unselect any headsites to avoid associating the pipe with a zone. 
Draw the piping lines as above, except that the lines will be displayed as black dashed lines. You will be given the 
opportunity to select a pipe type/size which will more than likely be different than your system piping. Connect 
manifolds/sprinkler boxes together or draw main lines out to the main house connection or pressure/vacuum breaker 
valves. 

A word about the system hierarchy and component deletions:  WaterMark PRO is an object-oriented application.  This 
means that the various components of the system have hierarchical relationships.  For example, the project is the top 
object in the hierarchy, and projects are composed of plots and manifolds.  Headsites are assigned to plots, and if you 
delete a plot all headsites assigned to that plot are also deleted.  Zones are assigned to manifolds, and when a manifold 
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is deleted, so are the zones.  Pipe is assigned to zones, so when you delete a zone its system pipe is deleted.  Heads are 
not assigned to zones, but are referenced to a zone; therefore, if you delete a zone, the actual head is not deleted. 

Auto Add Pipe Tool 

 

The auto-design process can design system pipe for a single zone, an entire manifold’s assigned zones, or for all 
manifolds and zones in the project.  To design piping for a single zone, select any headsite member of that zone.   

Click the “Auto Add Pipe” button.  The system will ask whether you wish to design system pipe for all the drawing’s 
zones.  If you select “NO”, the system will design system pipe for only the selected zone.  If you select “YES”, the system 
will ask whether you wish to assign system pipe to all zones serviced by the parent manifold. 

If pipe is already assigned to the target zone, the system will prompt you of this fact and ask whether you wish to 
continue (existing system pipe will be deleted) or cancel out of the process. 

The “Auto Pipe Design Properties” window will now appear.  This window offers configuration options prior to the actual 
auto-assignment procedure: 

 

Main Line Orientation:  The process offers three different options for the orientation of the main system line feeding the 
zone’s headsites from a manifold.  Choose “Point-to-Point” to position main lines directly from the manifold position to 
the center of the zone’s interconnected lateral lines.  Choose “X-Axis” to direct the main line laterally along the 
drawing’s x-axis and then up or down the y-axis to the center point of the lateral lines.  Choose “Y-Axis” to direct the 
main line vertically along the y-axis and then across the x-axis to the center point of the lateral lines. 

System Pipe:  If you haven’t already selected system pipe for the zone, you may do so at this time.  See the manual 
system pipe procedure outlined above. 
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Once a pipe type is selected, click OK to assign pipe to your zone(s). Utilize the manual pipe properties tool above to 
tweak or modify the results of the auto-add pipe tool. 

Adding Associated Parts 

WaterMark PRO is a total system design tool.  As well as the normal functions of adding heads, zones, manifolds, etc., 
WaterMark PRO facilitates the addition of pipe, fittings, clocks & timers, valves, sprinkler accessories, sprinkler tools and 
even design and labor charges. 

Parts can be added to headsites, zones, manifolds, and even the entire project.  Headsite parts encompass everything 
common to the headsite other than the actual head.  This can include a riser, riser tee, auto drain valve or pipe clamps.  
After assigning parts to a headsite, the option exists to clone these parts to all heads on the plot.  Parts added to zones 
usually consist of everything from the zone valve to the headsite.  Like headsite parts, zone parts can be cloned to all 
zones on the manifold.  Project parts usually include entrance plumbing pipe and fittings, tools, accessories, and labor 
charges.  

Project parts can be added by clicking the “Add Project Parts” button from the Project toolbar.  Add project parts from 
the “Edit Project Parts” screen. 
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Importing/Scanning A Tracing Image 

WaterMark Pro supports the ability to import an image into the system, providing for a background graphic where plots 
can be traced. Once imported, images can be resized, moved, flipped/rotated, and the project’s scale and 0,0 reference 
point can be matched to the image. The system also includes a scanner utility that acquires images from most scanning 
devices. 

 

Acquiring an image through a scanner: 

Click the “Launch Scanner” menu item from the Project/Background Image panel to open the scanner utility.  
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Click the File/Capture menu from the Scanner menu to acquire the graphic displayed in the scanner. Save the file in your 
WaterMark Pro folder or any convenient folder you may wish to create. 

Importing an image: 

Click the “Load Image” menu item from the Project/Background panel. WaterMark Pro can import all popular image 
types (.jpg, .png, .gif) as well as any image scanned from the above scanning process. The image loads onto the drawing 
surface. These tracing images load onto the lowest level of the project’s drawing and may be imported at any time 
during or after the creation of plots or components, but it’s highly recommended that images get imported prior to 
creating plots, as more than likely the scale of the drawing will change based upon the imported image’s scale. 

We recommend placing drawings in a “landscape” orientation (horizontally) onto the drawing surface. In most cases, 
scanned images are created in a “portrait” orientation (vertically aligned). If so, load the completed graphic on to most 
any photo or painting program to rotate the orientation 90 degrees to landscape. 
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Utilize the “Project/Image Location & Size” slider controls: Resize Image menu, Horiz. Align menu, and Vert. Align to fit 
the image to the drawing surface. Make sure to fit the drawing close to the top and left sides of the drawing surface with 
none of the drawing outside of the drawing’s borders. Click the -/+ buttons to the right and left of the slider to micro 
adjust.  

 

If necessary, set the (0,0) X and Y point to match the drawing (0,0) point to the upper left-most point on the image. Click 
the Set (0,0)->(x, y) menu item. Click the point on your image where you want the (0,0) point of the drawing. To return 
the image to the original size/position, click the Set (x, y)->(0,0) menu item. 

If necessary, “Select A Rotate/Flip Combination” to change the image orientation. Rotating the original image 90 degrees 
will result in a distortion of the figures, so always use a third-party paint or photo program to rotate prior to loading it 
into the project 

Finally, click the “Launch Scale Matching” menu to initiate matching the drawing’s scale to the image. To match the scale 
of the drawing, first select a written dimension from the drawing and enter it in the “Image Dimension” text box. The 
next step is to click the “Launch Scale Matching” button which will guide you to click at the starting point on the drawing 
where the dimension begins. Once selected, click the end dimension. Once completed, the system’s scale will 
automatically match your drawing’s scale. Of course, for the system scale to be accurate, the drawing’s scale must also 
be accurate throughout. 
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Save your project to save the image settings. 

Add the plots, as discussed in the “Adding Plots” section above. Below is an example of two plots and headsites using 
the Auto Add Heads function. Note that when a graphic is loaded, the plot pattern fillers aren’t filled in so that the 
graphic’s details remain visible. 
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Adding to or Editing the Parts Database (full version only) 

The parts database is populated with many of the more common and popular heads, fittings, tools, and accessories 
utilized in basic sprinkler system design. No attempt has been made to provide an exhaustive list of parts, as the great 
majority of manufactured parts will never be used by most irrigation professionals. To address this issue, the database 
allows the designer to add their own favored parts. 

Open the database by clicking the “Edit Catalog” menu item: 

 

 

Click the “Manufacturer” drop list to select a manufacturer. Once selected, you can click the “New…” button to add a 
new manufacturer or the “Edit…” button to edit the selected manufacturer. 
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Once a manufacturer is selected, select a product type from the “Product Type” drop list. Once selected, select the 
manufacturer’s series from the “Mfg. Series” drop list. To view individual parts from the series, select from the 
Description drop list. Note that product types not related to the manufacturer are not shown. 

 

On the manufacturer’s series list, you can add a new series by clicking the “New…” button, you can edit the selected 
series by clicking the “Edit…” button or you can view details of the entire series by selecting the “View” button. 

On the Add/Edit Product Series dialog box, you can edit the manufacturer’s Series Number, Description, Associated 
Fitting (if available), and Features, for your personal notes. 

The Auto-Enabled checkbox should be checked if the head series is available to use in an Auto Head design function. To 
qualify, the series must include all standard fixed pattern heads (360, 90, 180 degree) or adjustable pattern heads. 

The Precipitation Rate Matched checkbox should be checked if the head series is precipitation rate matched. 

Note that fixed pattern heads should not be utilized in irregular-shaped plots (i.e., not rectangular), as they will be 
unable to satisfactorily cover plots with curved sides. We recommend using variable-pattern heads for these areas. 
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The following Series View… screen displays the heads comprising the series in a list with all permanent specs. (Please 
note: these specifications were taken from manufacturer and vendor product catalogs. Please verify specs prior to 
purchasing and installation.) Note the “Edit…” link in the furthest-right column. See the “Designer Favorites” topic 
above for details. 

 

Clicking the “Description” drop list from the Add/Edit Catalog Parts box displays each item in the series. Here you can 
add new items, edit various fields, and assign a retail and cost price which is referenced in the parts list report. 

 

Clicking the “Advanced” button from the above opens a new screen where detailed product information can be added 
or edited: 
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Reports 

 

WaterMark PRO features five basic reports that can be viewed or printed.  The “Heads by Plot” report lists all the system 
heads sorted by their parent plots.  This report displays plot type, location, area, and total precipitation rate, soil type, 
solar exposure, slope of grade, crest of slope, water demand, and recommended watering period and number of periods 
per week.  The head information includes head part numbers, location description, radius, angle, aim, and flow.  Use this 
report to assist in actual head layout on the property.   
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The “Heads by Zone” report lists heads sorted by their zone assignments.  This report shows zone number, total flow in 
zone, and all referenced heads with the same information as the “Heads by Plot” report.  Use this report to assist in zone 
construction and clock/timer configuration. 
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The “Pipe by Zone” report lists all system parts (including heads) in order of project, manifold, and zone.  This report is 
designed to simplify piping placement and may be utilized as a Bill of Materials or Estimate. 
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The “Parts by Zone” report lists all system parts (including heads) in order of project, manifold, and zone.  This report is 
designed to simplify zone construction and may be utilized as a Bill of Materials or Estimate. 
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The “Parts by Type” report is like the “Parts by Zone” report but lists all parts in order of the part type.  This report is 
extremely handy as a “pick list” or may also be utilized as a Bill of Materials or Estimate. 

 

For the parts reports, you can choose to show parts dealer costs, retails, or neither.  In most cases, when the reports are 
used as Bill of Materials or Estimates, you will choose to not show the dealer costs. 


